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AHB Advanced High Performance Bus FtERE 2

APB Advanced Peripheral Bus R AN LR

BMC Bus Matrix Controller S A 1

CAN Controller Area Network P25 1) 2% o IR 2
DDR Double Data Rate Memory KGR 2R ATAd 2
DLM Data Local Memory s R a4 2%
DMAC Direct Memory Access Controller IER R etk
DSP Digital Signal Processor SRS b
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ISA Instruction Set Architecture TR R4
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PLIC Platform Level Interrupt Controller | “F- & 2t i 1] 2%
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PMP Physical Memory Protection VI A AE DR
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R4 FHIE
MCU Core 5-stage in-order execution pipeline

Frequency: Max. 800MHz

Hardware multiplier
radix-2/radix-4/radix-14/radix-256/fast

Hardware divider

Optional branch prediction

4-entry return address stack (RAS)

Static branch prediction

Dynamic branch prediction
32/64/128/256-entry branch target buffer (BTB)
256-entry branch history

8-bit global branch history

Machine mode, Supervisor mode and User mode

Optional performance monitors

Misaligned memory access

RISC-V physical memory protection

ISA

RISC-V RV32I base integer instruction set

RISC-V "C" standard extension for compressed instructions

RISC-V "M" standard extension for integer multiplication and
division

RISC-V "A" standard extension for atomic instructions

MUG1031-1.2
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RISC-V "N" standard extension for user-level interrupt and
exception handling

RISC-V "F" and "D" standard extensions for single/double-
precision floating-point

DSP supported

Privilege

Machine, Supervisor and User privilege mode

Page-based virtual memory, supervisor mode and SV32 virtual
address translation scheme

128 number of shared Translation Lookaside Buffer (TLB) entries

8 number of instruction TLB entries

8 number of data TLB entries

16 number of support physical memory protection entries

Hardware performance monitors

Vectored PLIC extension

Hardware stack protection extension

Hardware performance throttling mechanism extension

Power
Management

Wait-for-interrupt (WFI) mode

Debug

RISC-V extend debug support

Number of breakpoints: 8

External JTAG debug transport module
JTAG: IEEE STD 1149.1 style 4-wire JTAG interface
Serial: 2-wire serial debug interface

PLIC

Configurable number of interrupts: 1-1023

Number of interrupt priorities: 15

Configurable number of targets: 1-16

Vectored interrupt extension

Support software interrupts

Support 16 user interrupts

PLMT

The RISC-V architecture defines a machine timer that provides a
real time counter and generates timer interrupts

Cache

I-Cache

Size: 32KB

Associativity: 4-way
Replacement policy: pseudo-LRU

6(55)
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3.2 RS
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Soft error protection: single/double error correction

D-Cache

Size: 32KB

Associativity: 4-way

Replacement policy: pseudo-LRU

Soft error protection: single/double error detection

Local Memory

ILM
Base: 0xA0000000
Size: 64KB

Soft error protection: single error correction and double error
detection

DLM
Base: 0xA0200000
Size: 64KB

Soft error protection: single error correction and double error
detection

Slave port supports local memory as a slave, can be accessed by
FPGA fabric as a master via the 64-bit Extended AHB Master bus

3.2 HFiiksr RS

FEA# A% R AL AR 3-2 Fr.
& 3-2 FHESR ARG

MUG1031-1.2
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Instruction Memory | Address: 0x80000000~0x8FFFFFFF

Size: Max. 256MB

Bus: AHB bus interface

SPI Flash Memory, ITCM or user customized memory

Frequency: less than 200MHz

Data Memory

Address: 0x00000000~0x7FFFFFFF

Size: Max. 2GB

Bus: AHB bus interface

DDR3 Memory, DTCM or user customized memory

Frequency: less than 200MHz
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3.3 MAHMNBARG

3.3 BLIMERSE

B EAN R R G RIFFIE IR 3-3 R .
& 3-3 BEIMERGHHE

RE

AL

SMU

SMU controls the flow of power and clock changes

UART1

The UART controller handles communications to the UART
interface.

Compatible with the 16C550A register structure
Support of the hardware flow control (CTS/RTS)
Support of hardware handshaking to the DMA controller
Option of by-8 or by-16 over-sampling frequency
Support of 64-entry transmit/receive FIFO depth

UART2

The UART controller handles communications to the UART
interface.

Compatible with the 16C550A register structure
Support of the hardware flow control (CTS/RTS)
Support of hardware handshaking to the DMA controller
Option of by-8 or by-16 over-sampling frequency
Support of 64-entry transmit/receive FIFO depth

PIT

The PIT controller is a set of compact multi-function timers, which
can be used as PWM or simple timers. Each multi-function timer
provides the following 6 usage scenarios:

One 32-bit timer

Two 16-bit timers

Four 8-bit timers

One 16-bit PWM

One 16-bit timer and one 8-bit PWM
Two 8-bit timers and one 8-bit PWM

WDT

The WDT controller prevents the system from hanging if software is
trapped in a deadlock condition.

Internal/external clock source selection

Separate timers for the watchdog interrupt and the system reset
Eight choices of watchdog timer intervals

Four choices of reset timer intervals

Register write protection for watchdog timer control register and
restart register

Configurable magic number for register write protection

MUG1031-1.2
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Configurable magic number to restart the watchdog timer

RTC

RTC keeps track of current time relative to a base time. The time is
stored in a RTC counter which records the amount of elapsed time
since RTC is enabled.

The frequency of clock source (before the clock divider) for the
counter is 32.768KHz

Separate second, minute, hour and day counters

Periodic interrupts: half-second, second, minute, hour and day
interrupts

Programmable alarm interrupt with specified second, minute and
hour values

GPIO

The GPIO controller supports up to 32 channels with independently
programmable input/output control.

Support of up to 32 GPIO channels
Independent control of each channel
Programmable 1/O direction

Optional pull-up/down control

Optional support of interrupt trigger control

Flexible combination of interrupt trigger modes: high/low level
trigger and rising/falling/both edge trigger

Optional de-bounce functionality for input channels

12C

The 12C controller handles communications to 12C interface.
Programmable to be either a master or a slave device
Programmable clock/data timing

Support of the 12C-bus Standard-mode (100 kb/s), Fast-mode (400
kb/s) and Fast-mode plus (1 Mb/s)

Support of hardware handshaking to the DMA controller

Support of the master-transmit, master-receive, slave-transmit and
slave-receive modes

Support of the multi-master mode
Support of 7-bit and 10-bit addressing modes
Support of general call addressing mode

Support of auto clock stretch

SPI

The SPI controller handles communications to the SPI. The
supported serial data formats range from 4 bits to 32 bits in length.

Compliant with AMBA 2 AHB protocol specification
Compliant with AMBA 3 APB protocol specification
Support of MSB/LSB first transfer

Support of DMA data transfer

9(55)
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Support of programmable SP1 SCLK

Support of memory-mapped access (read-only) through AHB bus or
EILM bus

Support of SPI slave mode

Quad I/O SPI interfaces

TX/RX FIFO depth is128

Programming port location on APB interfaces

DMAC

The DMAC enhances system performance by transferring large
data blocks between devices in background to offload the
processor.

Compliant with AMBA AXI4 and APB4
Support of up to 8 DMA channels

Support of up to 16 DMA request/acknowledge pairs for hardware
handshake, 7 internal used, 8 for user

Support of up to two AXI master ports for data transfers
Support of up to two configurable DMA cores

Support of an APB slave port for DMA register programming
Support of 24—64 bits AXI address width

Support of 32/64/128/256 bits AXI data width

Support of narrow transfers on the AXI bus

Support of group round-robin arbitration scheme with 2 priority
levels

Support of chain transfers

Extended
APB Slave

For user to extend APB interface peripherals in FPGA fabric
32-bit data bit width

Size: 64MB

AE350_SOC is as a master

Extended
AHB Slave

For user to extend AHB interface peripherals in FPGA fabric
32-bit data bit width

Size: 128MB

AE350_SOC is as a master

Extended
AHB Master

For slave port supported, assesses local memory by a master in
FPGA fabric

64-bit data bit width
AE350_SOC is as a slave

10(55)
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DDR 4 /NF 200MHz HARAL 2R B
AHB It} /NF- 200MHz AHB 2R B R A 17t 25 15
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® i Eh. DDR . AHB/APB 4, =% 2 A5
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Gowin RiscV_AE350_SOC #i#i& f71ifi &5 a1 51 DDR3 Memory, |
DDR3 Memory AHICIHIN Bk 4-2 Fros .

%% 4-2 DDR3 K4

DDRS3 I g e Eif i)
DDR3_MEMORY_CLK /NFE5T 300MHz JFH 4\ DDR3 itk A i
DDR3_RW_CLK KTEHET FPGA fabric #:5Vj;1i DDR3 1]
DDR3_MEMORY_CLK | £ A\ i ff
g5z —
DDR3_CLK_IN 50MHz DDR3 i A\ #1h
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4.3 tHEEIEER

Gowin RiscV_AE350_SOC 3 T F:#i i #2 /5 Dhrystone. CoreMark

FT Whetstone & 1P EFa bR 403K 4-3 BT
& 4-3 tEREIRER

FENATEF PEREFRAR

Dhrystone 1.72 DMIPS/MHz

CoreMark 3.224845 CoreMark/MHz

Whetstone 0.783 MWIPS/MHz
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Gowin RiscV_AE350_SOC 1 &4t H 4ngk 5-1 Fizr.

+® 5-1 RGeiw 0
e /0 hrvs | #k JiJ&
POR_RSTN input |1 Power on reset -
HW_RSTN input |1 Hardware reset -
CORE_CLK input | 1 Core clock -
DDR_CLK input | 1 Data memory clock -
AHB_CLK input 1 AHB or instruction -
memory clock
APB_CLK input |1 APB clock -
RTC_CLK input | 1 RTC clock RTC
TCK_IN input |1 JTAG clock Debug
TMS_IN input | 1 JTAG tms Subsystem
TRST_IN input | 1 JTAG trst
TDI_IN input | 1 JTAG tdi
TDO_OUT output | 1 JTAG tdo
TDO_OE output | 1 JTAG tdo oe
FLASH_SPI_CSN inout |1 Flash chip select n SPI Flash
FLASH_SPI_MISO inout | 1 Flash master in and | Instruction
slave out Memory
FLASH_SPI_MOSI inout |1 Flash master out and
slave in
FLASH_SPI_CLK inout |1 Flash clock
FLASH_SPI_HOLDN inout |1 Flash hold n
FLASH_SPI_WPN inout |1 Flash write protection
n
FR_PCLK input |1 Flash register APB SPI Flash

13(55)
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clock Instruction
FR_PRESETN input | 1 Flash register APB Memory L1 &
reset n Flash Register
R/W Mode
FR_PADDR input | [31:0] | Flash register APB
address
FR_PENABLE input | 1 Flash register APB
enable
FR_PRDATA output | [31:0] | Flash register APB
read data
FR_PREADY output | 1 Flash register APB
ready out
FR_PSEL input |1 Flash register APB
select
FR_PWDATA input | [31:0] | Flash register APB
write data
FR_PWRITE input | 1 Flash register APB
write enable
ROM_HADDR output | [31:0] | ROM AHB address Customized
ROM_HRDATA input | [31:0] | ROM AHB read data | Instruction
Memory
ROM_HREADY input |1 ROM AHB ready in
ROM_HRESP input |1 ROM AHB response
ROM_HTRANS output | [1:0] | ROM AHB
transmission type
ROM_HWRITE output | 1 ROM AHB write
enable
ROM_HCLK output | 1 ROM AHB clock
ROM_HRSTN output | 1 ROM AHB reset n
DDR3_MEMORY_CLK | input |1 DDR3 memory clock | DDR3 Data
DDR3_CLK_IN input | 1 DDR3 input clock Memory
DDR3_RSTN input |1 DDR3 reset
DDR3_LOCK input | 1 DDR3 lock
DDR3_STOP output | 1 DDRa3 stop
DDR3_INIT output | 1 DDRa initialized flag
DDR3_BANK output | [2:0] | DDR3 bank address
DDR3_CS_N output | 1 DDR3 chip select
DDR3_RAS_N output | 1 DDR3 row address

14(55)
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select
DDR3 _CAS N output | 1 DDRS3 column
address select
DDR3_WE_N output | 1 DDR3 write enable
DDR3_CK output | 1 DDR3 clock
DDR3_CK_N output | 1 DDR3 clock
differential
DDR3_CKE output | 1 DDRa3 clock enable
DDR3_RESET_N output | 1 DDRa3 reset
DDR3_ODT output | 1 DDR3 on-die
termination
DDR3_ADDR output | [13:0] | DDR3 address
DDR3_DM output | [1:0] | DDR3 data mask
DDR3_DQ inout | [15:0] | DDRS3 data
DDR3_DQS inout | [1:0] | DDRS data select
DDR3_DQS_N inout | [1:0] | DDRS3 data select
differential
clk_lane4 input |1 Writing clock DDR3 Data
addr_lane4 input | [31:0] | Writing address Memory L1 &
Shared DDRa3:
wr_mask_lane4 input | [3:0] | Writing mask Logic RIW
wr_data_lane4 input | [63:0] | Writing data Mode
[31:0]
wr_en_lane4 input |1 Writing enable
wr_go_lane4 input |1 Writing control
burstcount_lane4 input | [7:0] | Writing burst amount
wr_wait_lane4 output | 1 Writing wait
wr_done_lane4 output | 1 Writing done
clk_lane5 input |1 Reading clock
addr_lane5 input | [31:0] | Reading address
rd_en_lane5 input |1 Reading enable
rd_go_lane5 input |1 Reading control
burstcount_lane5 input | [7:0] | Reading burst
amount
rd_valid_lane5 output | 1 Reading valid
rd_data_lane5 output | [63:0] | Reading data
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[31:0]

rd_rdy_lane5 output | 1 Reading ready
DDR_HADDR output | [31:0] | DDR AHB address Customized
DDR_HBURST output | [2:0] | DDR AHB burst Data Memory
DDR_HPROT output | [3:0] | DDR AHB protection
DDR_HRDATA input | [63:0] | DDR AHB read data
DDR_HREADY input | 1 DDR AHB ready in
DDR_HRESP input | 1 DDR AHB response
DDR_HSIZE output | [2:0] | DDR AHB size
DDR_HTRANS output | [1:0] | DDR AHB

transmission type
DDR_HWDATA output | [63:0] | DDR AHB write data
DDR_HWRITE output | 1 DDR AHB write

enable
DDR_HCLK output | 1 DDR AHB clock
DDR_HRSTN output | 1 DDR AHB reset n
EXT_INT input | [15:0] | Extended interrupts PLIC
APB_PADDR output | [31:0] | APB slave address Extended APB
APB_PENABLE output | 1 APB slave enable Slave
APB_PRDATA input | [31:0] | APB slave read data
APB_PREADY input |1 APB slave ready in
APB_PSEL output | 1 APB slave select
APB_PWDATA output | [31:0] | APB slave write data
APB_PWRITE output | 1 APB slave write

enable
APB_PSLVERR input |1 APB slave error

response
APB_PPROT output | [2:0] | APB slave protection
APB_PSTRB output | [3:0] | APB slave write

strobe
APB_PCLK output | 1 APB slave clock
APB_PRSTN output | 1 APB slave reset n
EXTS_HRDATA input | [31:0] | AHB slave read data | Extended AHB
EXTS_HREADYIN input | 1 AHB slave readyin | Slave
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EXTS_HRESP input | 1 AHB slave response
EXTS HADDR output | [31:0] | AHB slave address
EXTS_HBURST output | [2:0] | AHB slave burst
EXTS_HPROT output | [3:0] | AHB slave protection
EXTS_HSEL output | 1 AHB slave select
EXTS_HSIZE output | [2:0] | AHB slave size
EXTS_HTRANS output | [1:0] | AHB slave

transmission type
EXTS_HWDATA output | [31:0] | AHB slave write data
EXTS_HWRITE output | 1 AHB slave write

enable
EXTS_HCLK output | 1 AHB slave clock
EXTS_HRSTN output | 1 AHB slave reset n
EXTM_HADDR input | [31:0] | AHB master address | Extended AHB
EXTM_HBURST input | [2:0] | AHB master burst Master
EXTM_HPROT input | [3:0] | AHB master

protection
EXTM_HREADY input |1 AHB master ready in
EXTM_HSEL input |1 AHB master select
EXTM_HSIZE input | [2:0] | AHB master size
EXTM_HTRANS input | [1:0] | AHB master

transmission type
EXTM_HWDATA input | [63:0] | AHB master write

data
EXTM_HWRITE input |1 AHB master write

enable
EXTM_HRDATA output | [63:0] | AHB master read

data
EXTM_HREADYOUT | output | 1 AHB master ready

out
EXTM_HRESP output | 1 AHB master

response
DMA REQ input | [7:0] | DMA requests DMAC
DMA_ACK output | [7:0] | DMA acknowledges
SPI_HOLDN_IN input | 1 SPI hold nin SPI L\ k& non-
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SPI_WPN_IN input | 1 SPI write protection n | I/O ports
in
SPI_CLK_IN input | 1 SPI clock in
SPI_CSN_IN input |1 SPI chip select nin
SPI_MISO_IN input |1 SPI miso in
SPI_MOSI_IN input |1 SPI mosi in
SPI_HOLDN_OUT output | 1 SPI hold n out
SPI_HOLDN_OE output | 1 SPI hold n oe
SPI_WPN_OUT output | 1 SPI write protection n
out
SPI_WPN_OE output | 1 SPI write protection n
oe
SPI_CLK_OUT output | 1 SPI clock out
SPI_CLK_OE output | 1 SPI clock oe
SPI_CSN_OUT output | 1 SPI chip select n out
SPI_CSN_OE output | 1 SPI chip select n oe
SPI_MISO_OUT output | 1 SPI miso out
SPI_MISO_OE output | 1 SPI miso oe
SPI_MOSI_OUT output | 1 SPI mosi out
SPI_MOSI_OE output | 1 SPI mosi oe
SPI_HOLDN inout | 1 SPI hold n SPI LK 110
SPI_WPN inout | 1 SPI write protection n | POrs
SPI_CLK inout |1 SPI clock
SPI_CSN inout | 1 SPI chip select n
SPI_MISO inout |1 SPI master in and
slave out
SPI_MOSI inout |1 SPI master out and
slave in
I2C_SCL_IN input | 1 12C clock in 12C LA non-
12C_SDA_IN input | 1 12C data in /O ports
12C_SCL_OUT output | 1 12C clock out
12C_SDA_OUT output | 1 I12C data out
I2C_SCL inout | 1 12C clock 12C LLK 110
I2C_SDA inout | 1 I2C data ports
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UART1_TXD output | 1 UART1 transmits UART1
data
UART1_RTSN output | 1 UART1 rts n
UART1_RXD input |1 UART1 receives data
UART1_CTSN input | 1 UART1 cts n
UART1_DSRN input | 1 UART1 dsrn
UART1_DCDN input | 1 UART1 dcd n
UART1_RIN input | 1 UART1 rin
UART1_DTRN output | 1 UART1 dtr n
UART1_OUT1IN output | 1 UART1 out1 n
UART1_OUT2N output | 1 UART1 out2 n
UART2_TXD output | 1 UART2 transmits UART2
data
UART2_RTSN output | 1 UART2 rts n
UART2_RXD input |1 UART2 receives data
UART2_CTSN input | 1 UART2 cts n
UART2_DSRN input | 1 UART2 dsrn
UART2_DCDN input | 1 UART2 dcd n
UART2_RIN input | 1 UART2 rin
UART2_DTRN output | 1 UART2 dtr n
UART2_OUT1IN output | 1 UART2 out1 n
UART2_OUT2N output | 1 UART2 out2 n
CHO_PWM output | 1 PWM channel 0 PWM
output
CHO_PWMOE output | 1 PWM channel 0
output enable
CH1_PWM output | 1 PWM channel 1
output
CH1_PWMOE output | 1 PWM channel 1
output enable
CH2_PWM output | 1 PWM channel 2
output
CH2_PWMOE output | 1 PWM channel 2
output enable
CH3_PWM output | 1 PWM channel 3
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output
CH3_PWMOE output | 1 PWM channel 3

output enable
GPIO_IN input | [31:0] | GPIO in GPIO LL & non-
GPIO_OE output | [31:0] | GPIO output enable | /O ports
GPIO_OUT output | [31:0] | GPIO output
GPIO inout | [31:0] | GPIO GPIO LK 110

ports

COREO_WFI_MODE output | 1 Core WFI mode SMU

status
RTC_WAKEUP output | 1 RTC wakeup status
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Gowin RiscV_AE350_SOC I R4 & in#k 6-1 Fizr.

* 6-1 RGERE

i £ 16 100 ETNN Y 1

Enable Extended Interrupts K TR R 16 AN ahE Wi {E 5

SPI Flash Instruction Memory | JF /2 g4 1% #%: SPI Flash Memory

Flash Register R/W Mode eS| JFJ5 Flash 27 #7220 APB sl 4%
|

ITCM Instruction Memory K] a4 fitEds: 1ITCM

ITCM Size KM ITCM ¥ K71

ITCM Initialization Path I ITCM IHIaHH B8 4%

Customized Instruction KA fa & fEftas: F A E LG

Memory

DDR3 Data Memory A i 17t 2s: DDR3 Memory

Default DDR3 Settings AN 2RiAI¥) DDR3 Memory Interface IP [f]
ZH I E

Customized DDR3 Settings PN F 7 E 5 X DDR3 Memory Interface

IP IS B

Shared DDR3: Logic R/W K H] MCU i 5 FPGA i3t = ijj 1] DDR3

Mode Memory

Addr Width K H] FPGA iiii1/j i) DDR3 Memory [fJ il i
A VA

Data Width K FPGA iiiji ] DDR3 Memory FI ¥ i
LA

DTCM Data Memory KA it ds: DTCM

DTCM Size KM DTCM ik

Customized Data Memory KMl Bafifitiae: H A LGS

Enable Extended AHB Slave | /4] FIEH R 32-bit AHB Slave £ [1,

AE350 1£: Master
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Enable Extended AHB Master | 5% FFJEY () 64-bit AHB Master %11,
AE350 £ Slave 1% #

Enable Extended DMAC K] TFEY K 8 41 DMA i R/IMZM5 5

Enable 12C K FIg 12C

Enable 12C I/O Ports AV FFJE 12C “INOUT” 27 it [

Enable PIT K JHE PIT

PWM Channel 0 K T 5 PWM idiE 0

PWM Channel 1 K T PWM idiE 1

PWM Channel 2 K a3 PWM ifiE 2

PWM Channel 3 K 3 PWM ifiE 3

Enable SPI K FF)e SPI

Enable SPI 1/O Ports AN TP SPI “INOUT” 25743 1

Enable UART1 K )3 UART1

Enable UART2 K )3 UART2

Enable GPIO K )5 GPIO

Enable GPIO I/O Ports AN JFJ5 GPIO “INOUT” KAk [

Enable WDT K JFi5 WDT

Enable RTC THiE JFiE RTC

Enable SMU KA FFJg SMU

Enable Extended APB Slave KM IR ) 32-bit APB Slave #11,
AE350 £y Master
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7.1 TEAEHR

7.1 B

® DK-START-GW5AT138 V2.1
-  GW5AST-LV138FPG676AES
-  GWb5AST-138B

® Tang-MEGA-138K-Pro-Dock

WitiRiE

7.2 B A

7.3 &itRE

MUG1031-1.2

-  GW5AST-LV138FPG676AES
- GW5AST-138B

AR AR Z I Gowin_V1.9.9.03 (64-bit).

Gowin RiscV_AE350 SOC IP ¥ ilifsE, k.

Bz PR 1P % T A “IP Core Generator”, Fit#E
RiscV_AE350_SOC IP #57i, 7=/ RiscV_AE350_SOC IP it

EIRAER) IP %1t T H “IP Core Generator” 7, Ft& PLL_ADV
IP &I, 7=4: PLL_ADV IP ¥#it, N RiscV_AE350_SOC IP #fftifh
B, 924k RiscV_AE350_SOC IP, szfil1k PLL_ADV IP, il
ANHABH PR, RS B e B TR Wt

ST HTERI, IMAYIBERLI W, v LA 2R s 2 e T A

FloorPlanner;

SR o e, TN R Z95R, AT DS 2 I BRI I e 249 3R
T. A Timing Constraints Editor;

PO E LR BRI AR AT 2 U AL I 1L 01 5
i ] = VR 24 T B GowinSynthesis £ 4 RiscV_AE350_SOC fifl
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it AR

8. M H = IR JRAT L T A Place & Route, fiiJRifi&kM& S, ™=
ARG S

9. f#iH =IREAL T # T H Programmer, K& SO,
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81¥2H1i§ti+7’5525
8.1 By T2

$E1

WA ATH =R, % L8 “File > New... > FPGA Design
Project”, (T HAZ “L1”, 8{ “Quick Start” ##25F “New Project...”,
o “OK”, Wi 8-1 iR

8-1 New Project

9 -8 %
DEEE & i
Recent Projects:
Quick Start
== E= E=
W New ? x
N

v Projects
Teol 2% FPGA Design Project

| |Create a FPGA design project. L
You will be able to add or create RTL sources, run synthesis,
place & route, and program your device.

! Cance

Start Page [x]

B2
WE TRV TS, Bidi “Next”, WKl 8-2 frr.
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[&] 8-2 Project Name

W Project Wizard X

Project Name
E» Project Name
Select Device Enter a name for your project, and specify a directory where the project will be stored. The directory will be

. created if it doesn't exist.
Summary

MName: |ae$50_demo |

Create in: |C:\Users\\iukai\Desktop |

[] Use as default project location

ext = Cancel

+5% 3

WHEBMHEE, 45 Series. Device. Device Version. Package-
Speed #1 Part Number, .7 “Next”, #1 8-3 Fizn.

(ZLUE

Series: GWSAST

Device: GW5AST-138

Device Version: B

Package: FCPBGAG76A

Speed: ES

Part Number: GW5AST-LV138FPG676AES
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8.2 IP #it

& 8-3 Select Device

W Project Wizard x

Select Device
Project Name

E» Select Device Specify a target device for your project
Summary Filter
Series: GWSAST ¥ | Package: |FCPBGAB76A -
Device: GWSAST-138 v | Speed: ES -
Device Version: B -

#no version number is initial version

Part Number Device Device Version Package Speed  Voltage

(GWSAST-LV138FPGG76AES |awsast13s |8 [Fcpeaacres

= Back ext = Cancel

=

B4
e ARG, By “Finish”, WK 8-4 Fis.
8-4 Summary

W Project Wizard X

Summary
Project Name

Select Device Project
Eb STy N?me: ae358_demo . .
Directory: C:\Users\liukai\Desktop
Source Directory: C:\Users\liukai\Desktop\ae35@_demo\src
Implementation Directory: C:WUsersi\liukai\Desktop\ae358_demoiimpl

Device
Part Number: GWSAST-LV13BFPGE7BAES
Series: GWSAST
Device: GWSAST-138B
Package: FCPBGAGTBA
Speed: ES

= Back Cancel

8.2 IP it

MUG1031-1.2

TIREAER IP &1t T2 “IP Core Generator”, &
RiscV_AE350_SOC #%%, /£ RiscV_AE350_SOC IP.

IR PRS2 “Tools > IP Core Generator”, B¢ T E.#*
“d87”, $T7F IP Core Generator, %+ “Soft IP Core > Microprocessor
System > Hard-Core-MCU > RiscV AE350 SOC 1.27, #& 8-5 7.
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& 8-5 IP Core Generator

GOWIN FPGA Designer - [IP Core Generator]

| Ele Edit Project Tools Window Help

-8 %

DEEHS = SEY S N
Desion T X Target Device: | GWSAST-LV13BFPGETGAES
v ae350_demo - [FAEMB_puble... |[r. - ‘
GW5AST-LV138FPGG7GAES N — .
RiscV AE350 SOC
Physical Canstraints Files ITe)
Timing Constraints Fles MIpI_DPHY Information
Memary
SEU Type: RiscV AE350 S0OC
SPMI Vendor: GOWIN Semiconductor
User Flash
v Soft IP Core s
Al ummary
BackGround Configuration
DSP and Mathematics RiscV AE350 SOC platform integrates A25 Core, a 32bit CPU base on
Interface and Interconnect RISC-V. There are UARTO, UART1, SPI, 12C, PIT, 32bit GPIO, DMA, WDT,
Memory Control RTC and SMU peripherals integrated in this platform. Extended AHB
~ Microprocessor System master and slave interface and APB interface can be used by user to
Bus Bridge define their own SOC system.
v Hard-Core-MCU
o G _EMPU(G 2 A25 Cere is a 32-bit CPU IP core which incorporated RISC-V technology, it
&b Riscv AE350 SOC 1.2 is capable of delivering high per-MHz performance and operating at high
Soft-Core-MCU freguencies, at the same time it is small in gate count. A25 Core also
Multimedia . supports hardware multiplier, hardware divider, single-precision and
3 Serhes B double-precision fleating point instructions, and MMU for Linux based -
Design  Process  Hierarchy g Start Page 8 Design Summary B & IP Core Generator [ix]
Console B %
%
Console ~ Message

Mt “RiscV AE350 SOC 1.2”

& 8-6 frn.

, #TTF RiscV_AE350_SOC IP Core,
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[& 8-6 RiscV_AE350_SOC IP Core

A RiscV AE350 SOC ? X

General

Device: |GW5AST-13G | Device Version: |B ‘

Part Number: [ GWSAST-LV138FPG676AES |

Create In:  H\risc \ae350_soc\ref_design\1.2\FPGA_RefDesign\DK_START_GWSAT138 V2.1\a=350_demo\sre\riscv_ae350_soc| .. |

File Name: riscv_ae350_soc Module Name: |RiscV_AE350 SOC Top

Language: |\|"er|'|og ~

EEIE0S0C A

AE350 Subsystem

g
B
=
12c PT =PI UARTT UARTZ GPID WOT RTC U Baended APE
Slave v
[ ok ]| cancel |

RiscV_AE350_SOC AJ it & 1) 24t Vi Re 4% PLIC. Instruction
Memory (fi# SPI Flash. ITCM. Customized). Data Memory (%
DDR3. DTCM. Customized). 12C. PIT. SPl. UART1. UART2.
GPIO. WDT. RTC. SMU. DMAC. Extended APB Slave. Extended
AHB Slave #il Extended AHB Master, [t B &N 6-1 ik .

PAN B PR FR A R G T REA L T A I BT i
8.2.1 PLIC

AT “PLIC”, BCE “PLIC” &5, 40
8-7 flr .

%S “Enable Extended Interrupts”, TFFJE 4 &1 16 AN4hHH
WrfEs, BRASKH.
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[E 8-7 PLIC fit B

% PLIC ? x

PLIC &

The PLIC (Platform Level Interrupt Controller) module of RiscV AE350 SOC is for user level
extended interrupts, including configurable interrupt trigger types, software programmable interrupt

— generation, preemptive priority interrupt extension and vectored interrupt extension.
— If users enable the extended interrupts, it could export 16 extended interrupt signals.
—
—

00 AT
]
—
— T
e Option
e -
— T .

Configuration
—
= o7 WS Enable Extended Interrupts
RecV ALIS0 SOC

8.2.2 Instruction Memory

SPI Flash

WidiTH “SPI Flash”, B SPI Flash #5417 fif 85k 1, Wil 8-8 fr
Z—\‘o

W% “SPI Flash Instruction Memory”, JIJT /= SPI Flash
Memory 1EH%a & 17fk#%, BRIAJFA SPI Flash Memory.

WP “SPI Flash Instruction Memory”, ] LAt & Flash
Register R/\W Mode. WIHiE# “Flash Register R/'W Mode”, NIF &
Flash Zif7 a8 B0 APB S 28211, Flash o] LL/ESNAMNK, J8id BF 748 152
BAMERREAE, BOAKH

Flash Register R\W Mode [#)3 FH SEf1iE 2 “.. \example\Flash”.
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[E 8-8 SPI Flash fit &

Instruction Memory:SPI Flash o

The Instruction Memory module of RiscV AE350 SOC is for booting or running MCU instruction.

SPI Flash Memory can be as Instruction Memory.

SPI Flash is also allowed to access Flash with register mode, this is, users can erase, read and
write flash as a peripheral.

i

Options

Configurations

N I I

Instruction on Memory Select

5Pl Flash Instruction Memary

i
i

SPI Flash Options

R PREAY

)

YTy

Flash Register R/W Mode

RiscV AE350 S5OC
W

OK Cancel

ITCM

MAFTH “ITCM”, BLE ITCM 82 fE it nl, ik 8-9 Fix.

IR EFE “ITCM Instruction Memory”, TIJT & ITCM 15 454 17
. BRI ITCM,

WERFF “ITCM Instruction Memory”, AT PAEE & ITCM Size Al
ITCM Initialization Path.

ITCM Size "] LAECE ~ 32KB. 64KB. 128KB. 256KB F1 512KB, X
NN 64KB.

ITCM Initialization Path 7] LAFC & ITCM BV E AT, EP
RiscV_AE350_SOC #F4mE T $ATIE T, BRIV =R R 1 2  H4% R Tl
BT . ITCM FRIGEE U A 4 1752k fil S04 itemO.
item1. item2 Fl item3, H =4
“...\example\TCM\tool\make_hex” T HAL i AFgm e vl PATRE 7 i3k
A%, B make_hex.exe binary-file .

ITCM [P I SEFE 2 “.. \example\TCM”,
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& 8-9 ITCM LB

Jb ITCm ? x

Instruction Memory:ITCM oo

The Instruction Memory module of RiscV AE350 SOC is for booting or running MCU instruction.
ITCM Memeory can be as Instruction Memary.
— FOR RETH
— e TN
—
— Ll TID0 CUT —i
Options
—
— e ~
Y Configurations
— e ToOCE [~ Instruction on Memory Select
— T
JE ITCM Instruction Memory
— .
ITCM Options
A ITCM Size: 64KB v
ITCM Initialization Path: b3_x64,-’|DE,-’ipcore,-’Ri5cV_AEESO_SOC,-’data,-’itcm_initial|
v

Customized

W IT “Customized”, BiE Customized 54 17fik 2k 10, 4nl&
8-8 T/

Rk “ Customized Instruction Memory”, I JTi ROM AHB &£k
B0, H A LLE E AP e ENTE 21 ds, ERIASCH] Customized.

Customized [N sziE 208 .. \example\Customized”.

& 8-10 Customized 2 &

¢% Customized ? X
Instruction Memory:Customized o

The Instruction Memory module of RiscV AE350 SOC is for booting or running MCU instruction.
Users can customize a memory controller and device to be as Instruction Memory.

—| PR T
— o o o [t
) cohr
—{oa o e
—»{uaa

= -
—{am e
e

L
—{ o i

Options
— T
e e

—{ T
. R . Configurations
P
R I Instruction on Memary Select
— R

Customized Instruction Memory

R AESSO SOC
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DA A GRS IN 7S, AL AU R LM
WA Z M) SPI Flash Memory, i%#£# SPI Flash Instruction
Memory.

U548 F FPGA fabric [1] BlockRAM, 1i#5i%3%¢ ITCM Instruction
Memory.

U R AR AR R A 2%, 5% 8 Customized Instruction Memory,
FI P 5E X AHB Memory S 25 5; 1 ({48 4 17 i Sa 5 i 2% .

8.2.3 Data Memory

DDR3
MAiTIF “DDR3”, BLE DDR3 ¥ fffasiL i, il 8-11 fizm.

Wik “DDR3 Data Memory”, N j5 DDR3 Memory 1E A% 7
fiti#y, ERINFF)5 DDR3 Memory.

mEIF g “DDR3 Data Memory”, NIAJ DAL E DDR3 Settings #ll
DDR3 Options. DDR3 Settings .7 “Default DDR3 Settings” #
“Customized DDR3 Settings ”.

Default DDR3 Settings 3~ z I3 {2 25 %42 T Tl & 1) DDR3
Memory Interface IP [{JERiA S HHLHE

U P AR ELE RS AN [F 28 DDR3 Memory Interface 112 4L
B, AT 7 H A0, HAR LA sE “DDR3 Memory
Interface” IP BLECE S-S0k D. 2854 7= 421" DDR3 Memory
Interface IP HISH L & 0 “gwme_param.v” JE T =I5 #2025 i 4%
“..\IDE\ipcore\RiscV_AE350_SOC\data\ddr3_custom_settings\” T. #
JAi%#E “Customized DDR3 Settings”, 774 RiscV_AE350_SOC IP, Hi}y
F P E %€ X DDR3 Memory Interface.

DDR3 Options f1 % “Shared DDR3: Logic R/W Mode”. “Addr
Width” 1 “Data Width”.

Shared DDR3: Logic R/W Mode #7~x FPGA fabric #1355 75 1] DDR3
Memory, E MCU il FPGA fabric it i] PL3L 2 [F] B 5 17] DDR3
Memory, ERilIKEH].

Addr Width FoRthk 22 ve, " LARCE A 32,
Data Width s 8dli S Ar s, FTLARCE Y 32 A164, ERIAN 32,

Shared DDR3: Logic R/W Mode 3% FH S5l i# 2 1
“..\example\DDR3_Shared”.
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[E 8-11 DDR3 it B

w DDR3 [ s

Data Memory:DDR3 o

The Data Memory module of RiscV AE350 SOC is far running MCU data or instruction.

DDR3 Memory can be as Data Memary.,

DDR3 Memory module is a multi-port interface, in addition to MCU, FPGA fabric is also allowed to
access DDR3 Memory.

-
-
R
—
—-

Options

Fhdbdbbbd

DDR3 Data Memaory "

(® Default DDR3 Settings

(O Customized DDR3 Settings

ML

DDR3 Options

Shared DDR3: Logic R/W Mode

Addr Width: |32 +

Data Width: |32 ~

I A S T A A

NEERRRRY

W

DTCM
WAATHF “DTCM”, L& DTCM Hdi /7.6 233151, w1 8-12 ik,

Wik FE “DTCM Data Memory”, NIH 5 DTCM {E N7 fig2%, Bk
N[ DTCM.

IS “DTCM Data Memory”, NITJ LAFE & DTCM Size.

DTCM Size 1] AL E N 32KB. 64KB. 128KB. 256KB #i1 512KB, #k
NN 64KB.

DTCM HINH s2BiE S “.. \example\TCM”,
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& 8-12 DTCM i B

sw DTCM

Data Memory:DTCM

? X

&

The Data Memory module of RiscV AE350 SOC is for running MCU data or instruction.
DTCM Memory can be as Data Memary.
— R
— TN
— o
— O O D0 AT
e Options
—
— s e . ~
Configurations
— TCE M TOO CE —i-
— s Data Memory Select
i i DTCM Data Memory
—
DTCM Options
RiecV AE350 SOC
DTCM Size: 64KB ~
v
Customized

KT IT “Customized”, B B Customized i 17 4% 25 1L 1,

8'13 ﬁﬁ}j_‘—\‘o

n

W% FE “ Customized Data Memory”, NI JTji DDR AHB =261,
F P AT LLA € A SR B 7 it 85, BRIA ] Customized.

Customized [ sz)iE 218 “.. \example\Customized ”.

8-13 Customized 2 &

! Customized

Data Memory:Customized

? X

e

Users can customized a memory controller and device to be as Data Memory.

The Data Memory module of RiscV AE350 SOC is for running MCU data or instruction.

i i o o
o
o0 o e
—com
J i [t
o e
—fam I
—arc
cmrm
e .
el meaa e | Options
—{rer R
T . Configurations
S R
PR E— i Data Memaory Select
et moas i )
Customized Data Memory

Resc AE3S0 SOC

Cancel
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BRI AR N 5, Al A2 N BLR LRMEIE

WM F 4 DDR3 Memory, i&iE# “DDR3 Data Memory”, %A
J& # 1% it Ff DDR3 Memory %% Default DDR3 Settings 5 Customized
DDR3 Settings.

A0 A FPGA fabric 1] BlockRAM, i%i%£# “DTCM Data
Memory”,

R A AR R A 2%, 5% “Customized Data Memory”, i J°
H & X AHB Memory s 28 #2 I 54 A7 il 2 428 1l 2%

WAFTH “12C7, FLE “12C7 @&, Wik 8-14 Fix.
® R EH “Enable 12C”, NIFF)H 12C, BRIAKH
® (RJTE 12C, WA LARCE 12C i A
- WREFE “Enable 12C I/0 Ports”, NIFF /5 12C “INOUT” K i
M, BWIFE “IN7. “OUT” Mg, Bk “INOUT” iy 88
8-1412C B E
e ? X
12C 5
The 12C module of RiscV AE350 SOC handles communications to the Inter-Integrated Circuit N
serial interface.
— o ST The I12C includes programmable to be either a master or a slave device, programmable clock/
[ o data timing, support of the 12C-bus Standard-mode and Fast-mode and Fast-mode plus, support
N I 1| of hardware handshaking to the DAMC,
N The 12C module is a peripheral of APB bus interface in AE350 SOC, If users enable 12C, it could
_._: - < || Export 12C signals for user level. o
el Option
— T . -
™" Configuration 2
—l
- bl nidd Enable 12C
= Interface:
RiscV AE3S0 SOC - Enable 12C I/O Ports w

WATH “PIT?, BB “PIT” %50, Wk 8-15 fix.

® ik “Enable PIT”, NIJFE PIT, ZRik<H

® WIRIFE PIT, M LARCE PWM JEiE
- WHESE “PWM Channel 07, UJF )5 PWM JiiE 0, BRIASCH]
- WRIEF “PWM Channel 17, WJFFjE PWM @& 1, BRiAKH
- WRIEF “PWM Channel 27, TJFFjE PWM iliE 2, BRIl
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- R %EE “PWM Channel 37, I E PWM iBiE 3, ZRIAEH
[& 8-15 PIT fie &

5% PiT ? X

PIT o

The PIT (Programmable Interval Timer) module of RiscV AE350 50C is a set of compact multi-
function timers, which can be used as PWM (Pulse Width Modulators) or simple timers.

The PIT module is a peripheral of APB bus interface in AE350 SOC. If users enable PIT and
select PWM channels, it could export PWM signals for user level.

I TS || - Base address: 0xF0400000
i i woct || - End address: OxFOAFFFFF "
—
o i X
—» Option
CHD PACE —

—a - .
— e R Configuration

. CHY PWACE —
T Enable PIT
— TCE N
e s PWM Channel Select
i e e e PWM Channel 0
— O3 PAACE —

PWM Channel 1

RV AE3S0 S0C

PWM Channel 2

PWM Channel 3

8.2.6 SPI

AT “SPI1”, BLE “SP1” %10, Wi 8-16 fis.
® NHikHE “Enable SPI”, NJT/E SPI, BRi\EH.
® NHIF)E SPI, N LAACE SPI b 11285

- W% “Enable SPI /O Ports”, MFF)E SPI “INOUT” Z$#d i
M, {IWHFE “IN”, “OUT”. “OE” ZKEMumH, ERiL “INOUT”

Ui 1287
8-16 SPI it &
2 SPI ? X

SPI )

The 5Pl module of RiscV AE350 SOC handles communications the Serial Peripheral Interface. G
The supported serial data formats range from 4 bits to 32 bits in length.

— o ST N The SPI supports both master and slave mode operations, memory-mapped accesses,
Y hardware handshaking to the DMAC, and the quad I/0 modes.
] o OO CE e The SPI module is a peripheral of APB bus interface in AE350 SOC. If users enable SPI, it could
. - export SPI signals for user level.
— Dl CLE S HOLDN
v
1 it -
i Option
— s e
— LI : lad
Configuration
i i SR -
I Enable SPI
SR OACE
b Interface:
RV AL3S0 SOC - Enable SPI I/O Ports v
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8.2 IP it

8.2.7 UART1 #1 UART2

iy “UART1” B “UART2”, BCE “UART1” B “UART2” &L,
i 8-17 Fk.

® Hi%EFE “Enable UART1”, MJT/E UART1, ERIAKH.
® Hi%EFE “Enable UART2”, MJT/5 UART2, ERIAKH.
8-17 UART1 #1 UART2 it &

W UART

UART

RYTTITTTRUVIRARITITS

The UART module of RiscV AE350 SOC handles communications to the Universal Asynchronous ™
Receiver/Transmitter serial interface.

The UART supports the hardware flow control (CTS/RTS), hardware handshaking to the DAMC,
64-entry transmit/receive FIFO depth, options of by-8 or by-16 over-sampling frequency.

The UART module is a peripheral of APB bus interface in AE350 SOC. If users enable UART1 ar
UART2, it could export UART1 or UART2 signals for user level.

UART1 UART2 hd

Options

Configuration
Enable UART1
Enable UART2

DR I N

8.2.8 GPIO

MUG1031-1.2

MEFTH “GPIO”, K& “GPIO” i&mi, 4nf& 8-18 fw.
® Ujlik$E “Enable GPIO”, NIJT/E GPIO, ER\KHI.
® HJTE GPIO, WIFLANCE GPIO i 1 257Y.

ik “Enable GPIO I/O Ports”, TIFF)i GPIO “INOUT” 27!
ST, FHMFFE “IN7, “OUT”. “OE” KA, BRik
“INOUT” 3 12670
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8.2 IP #it

[ 8-18 GPIO it &

v GPIO

GPIO

5

The GPIO (General Purpose 1/0) module of RiscV AE350 SOC supports up to 32 channels with ~ *
independently programmable input/output control.
— T The GPIO supports optional pull-up/down control, option interrupt trigger control, flexible
N combination of interrupt trigger modes, optional de-bounce functionality for input channels,
] coms e I The GPIO module is a peripheral of APB bus interface in AE350 SOC. If users enable GPIO, it
N could export GPIO signals for user level.
— w
— s DOCE e Optiol"l
= T
i i Configuration -
— TS S
ol s Enable GPIO
e Interface:
Risel AE3S0 SOC Enable GPIO I/O Ports v
8.29 WDT
MEATH “WDT”, BLE “WDT” &0, Wik 8-19 fis.
A A N
nFik#E “Enable WDT”, WIJF/E WDT, BRIAKH .
& 8-19 WDT EC &
& wDT 7 X

WDT

5

i TS 4

i T

=TI

TG AT

OO CE .

RecW AE3SD S0C

The WDT (Watch Dag Timer) module of RiscV AE330 SOC prevents the system from hanging if
software is trapped in a deadlock condition. A decrementing counter is maintained in WDT and a
watchdog interrupt will be generated once the watchdog timer reaches zero. The timer should be
restarted in the watchdog interrupt service routine.

The WDT module is a peripheral of APB bus interface in AE350 SOC.

- Base address: 0xFO500000
- End address: OxFOSFFFFF

Option

Canfiguration

Enable WDT

Cancel

8.2.10 RTC

MUG1031-1.2

WdidTH “RTC”, BLE “RTC” 1kIi,
FRNITJE RTC, AWK

ﬁu 8'20 Fﬁﬂ_‘—\‘o
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[ 8-20 RTC EL. B

ww RTC [} s

RTC o

The RTC (Real-time clock) module of RiscV AE350 SOC keeps track of current time relativeto a ™
base time. The time is stored in a RTC counter which records the amount of elapsed time since
— R EETY RTC is enabled.
ol o The RTC includes separate second/hour/day counters, periodic interrupts, and programmable
S alarm interrupt with specified second/minute/hour values.
. o The RTC module is a peripheral of APB bus interface in AE350 SOC.
— DO O D0 AT i
B - Base address: 0xFOG00000
—H|smas - End address: OxFOGFEFFE A
—»larce .
Option
— TCE N JCE —
! T
N Configuration
o Enable RTC
RiscW AE3S0 SOC

8.2.11 SMU

MWHFT I “SMU”, BiE “SMU” &, K 8-21 .
MR LS “Enable SMU”, NIJFE SMU, BRIAFEM] .
& 8-21 SMU E¢&

4 sMU ? X

SMU o

The SMU (System Management Unit) module of RiscW AE350 SOC controls the flow of power and
clock changes.

PR T The SMU module is a peripheral of APB bus interface in AE350 SOC., If users enable SMU, it could
T export SMU signals for user level.
T uT
ORE (]
e - Base address: 0xF0100000
. o:ls || - End address: OxFOTFFFFF

COREN WA MCDE [

bbb bbbt

- Option
5
s
- e Configuration
ST M
o Enable SMU
RuscV g 350 SOC

8.2.12 DMAC

WFFTH “DMAC”, BLE “DMAC” i&ui, Wik 8-22 fiix.

R % “Enable Extended DMAC”, NIFFEH B K 8 41 DMA &R/
NEES, BRIARHE.
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[ 8-22 DMAC it &

% DMAC ? X

DMAC &

The DMAC (Direct Memory Access Controller) module of RiscV AE350 SOC enhances system
performance by transferring large data blocks between devices in background to offload the
= s i processor.
— 3w The DMAC supports up to 8 extended DMA channels and up to 16 DMA request/acknowledge
— cons e rsncr e | | PaIrs for hardware handshake.
—d oa e If users enable the extended DMAC, it could export 8 extended DMA request/acknowledge pairs
—»sa e for user level.
—
TOO CE =

—
T Option
— TS

- " DAAA ACKTIN e
- Configuration
— TN
) s 072 Enable Extended DMAC

8.2.13 Extended APB Slave

Wi T T “Extended APB Slave”, Fil'E “Extended APB Slave” ik
Iﬁ’ ﬁﬂ@ 8'23 Fﬁﬂ—_‘—\‘o

Rk “Enable Extended APB Slave”, NS4 &1 32-bit APB
Slave #17, ZRiIAKH.

i#1d Extended APB Slave, 7] DLi#EH: FPGA 2 RSl APB &
LR 1R AR5

Extended APB Slave )3 F 524115 2 “.. \example\SD”,
“..\example\ APB_Slave Bridge ”. “...\example\Flash”.

8-23 Extended APB Slave Bt &

" Extended APB Slave ? *

Extended APB Slave o

The Extended APB Slave module of RiscV AE350 SOC is a standard APB bus interface. RiscV (o)
AE350 SOC is as master, user level side is as slave to extend the user level peripherals of APB bus
interface.

If users enable Extended APE Slave, it could export APB bus signals for user level.

Option

Configuration

Enable Extended APE Slave

Aoy AR SO0

MUG1031-1.2 41(55)




8 TEAN Bt T5 ik 8.2 IP #il

8.2.14 Extended AHB Slave

Mdr T “Extended AHB Slave”, Ei& “Extended AHB Slave” i%
I, W 8-24 Fos.

% “Enable Extended AHB Slave”, NF a4 Efr 32-bit AHB
Slave #1171, ZRiAKH .

i#iT Extended AHB Slave, ] LLi%E#: FPGA @5y FEsLILR) AHB &
KBRS,

Extended AHB Slave FJ3H LG 2 “.. \example\Ethernet”.
“..\example\ AHB_Slave Bridge”. “...\example\CAN”.

8-24 Extended AHB Slave fif &

' Extended AHB Slave ? x

Extended AHB Slave o

The Extended AHB Slave module of RiscV AE350 SOC is a standard AHB bus interface. RiscV
AE350 SOC is as master, user level side is as slave to extend the user peripherals of AHB bus
interface.

If users enable the Extended AHB Slave, it could export AHB slave bus signals for user level.

- Base address: 0xEBD00000
- End address: OxEFFFFFFF
- Size: 128MB

Option

Configuration

T ETYNERRRYNY

EERERERERARE

Enable Extended AHB Slave

8.2.15 Extended AHB Master

ME4TH “Extended AHB Master”, Ei& “Extended AHB Master”
eI, 4l 8-25 Fros.

R IEE “Enable Extended AHB Master”, NFF 54 &1 64-bit AHB
Master 311, ERIAFEH.
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[&] 8-25 Extended AHB Master Bt B
"o Extended AHB Master 7 x
Extended AHB Master L[,hll

The Extended AHB Master module of RiscV AE350 SOC is a standard AHB bus interface. RiscV
AE350 SOC is as slave, user level side is as master.
If users enable Extended AHB Master, it could export AHB master bus signals for user level.

FETTERTEYY

N Option
T - Configuration
:::“' Enable Extended AHB Master

i AHB Master $11, AE350 SOC %%:n] LIMENMAHL, FPGA
fabric 24t 7] LME N AL, FPGA fabric £%i)j 1] AE350 SOC &%t i1
ILM F1 DLM, MI# & T FPGA fabric &% [\I47fi% 23]

Extended AHB Master (1) 3 FH 545117 2 11
“..\example\AHB_Master”.

8.3 APt

8.3.1 RiscV_AE350_SOC IP #§&it

MUG1031-1.2

VRN IP %1t B “IP Core Generator”, 58/
RiscV_AE350_SOC IP it BJ5, #ii “OK”, /%4 RiscV_AE350_SOC IP
wit, WK 8-26 fin.
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[#] 8-26 RiscV_AE350_SOC IP i&it
W RiscV AE350 50C ? *
General
Device: |GW5AST-138 | Device Version: |B |

Part Number: | GWSAST-LV138FPG676AES |

Create In:  \risc_\ae350_soc\ref design\1.2\FPGA_RefDesign\DK_START_GWSAT138 V2.1\ae350_demo\srcriscy_ae350 soc| | ... |

File Name: riscv_ae350 _soc Module Name: |RiscV_AE350 SOC Top

Language: |\.|"er|'|og ~

AE3S0S0C

AE350 Subsystem

8.3.2 PLL_ADV IP it

MUG1031-1.2

ZIEEAER) IP it T B “IP Core Generator”, FEC& PLL_ADV IP i%
i, 7 PLL_ADV IP i, 39 RiscV_AE350_SOC IP AL iz i .

E IR AR kB 525 “Tools > IP Core Generator”, B¢ T. B4
“& 7, ¥THF IP Core Generator, ##% “Hard Module > CLOCK >
PLL_ADV 1.0”, 2% 4-1 fi% 4-2 it B PLL_ADV IP, 7% PLL_ADV
IP i%it, il 8-27 Fiiw.

#ilan: AT RiscV_AE350_SOC W[ PLL_ADV IP:

® ClkoutO: DDR clock
® Clkout1: CORE clock
® Clkout2: AHB clock
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® Clkout3: APB clock
® Clkout4: RTC clock

RiscV_AE350_SOC #j#is £ 1 #% 41 R i £ DDR3 Memory L\ & Shared
DDR3: Logic R'W Mode, DDR3 Memory ] PLL_ADV IP:

® Clkout0: DDR3 input clock

® Clkout1: DDR3 R/W clock

® Clkout2: DDR3 memory clock
[# 8-27 PLL_ADV IP i&it

% IP Customization ? x
PLL &
[ ]
General
Device: |GW5AST-133 | Device Versiom: |B ‘
Part Number: | GWSAST-LV1 38FPGE76AES | Lenguage: Verilog -
File Name: |gowin7p|| | Module Name: |Gowin7PLL ‘
Create In: CA\Users\liukai\Desktop\gw5Sast\ae350_dema\src\gowin_pll
— Common Clkoutd  Clkoutl Clkout2 Clkout3 Clkoutd  Clkouts Clkouté  Clifbout
d kot [~
— el o CLKIN PLL Reset "
— o encikl o Clack Frequency(10~400): |50.000 |Z PLL Reset
— e enclk2 Divider Factor [] PLL Power Down
ckout —-
e Dynamic Static |1 5] (1~64) [ CLKIN Divider Reset
kout
— ek [] CLKOUT Divider Reset
dous - VCO Frequency:
T el CLKFB Lack
Y
) s . Source: (@) Internal External Enable Lock
— bock [— Divider Factor
Dynamic Static |1 [+ (1~64)
ICP and LPF Optional Ports
ICPSEL SSC
Dynamic Static [ICP1 Clock Enable Ports
v

Cancel Calculate

!

® RiscV_AE350_SOC KNIt “PLL_R[0] > clkout1” ELEZAE, 2 4{#
PLL_ADV IP ] “clkout1” /=4 i 4.

® RiscV_AE350_SOC ) DDR3 Memory &l i1 “PLL_L[0] > clkout2” ELIEHRML, il
f§ /i PLL_ADV IP () “clkout2” 7#4: DDR3 Memory i 4t .

® DDR3 R/W clock >= (DDR3 memory clock/4).

8.3.3 APt

BT SR b, szl RiscV_AE350 _SOC IP, szfiilfk,
PLL_ADV IP, JnAJABF P 84881t R S gl il e B i 151t
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8.4 AR

8.4.1 YIBLAER
SIRFTFFERAR, IONPIELIR, AT L 2R R 4 ok T 2

“FloorPlanner”.

%22 i DK-START-GW5AT138 V2.1 DVK Board 5 Andes
AICE-MINI+1; 5A8 1 JTAG 2 L MR T, a1k 8-1 Fiow.

% 8-1 &M JTAG PR (Andes AICE-MINI+)

JTAG #1 DVK Board Andes AICE-MINI+1j; 5 %
GND J3-8 P3

™S J3-3 P4

TCK J3-4 P6

VREF (3.3V) J3-7 P7

TRST J3-5 P10

TDO J3-6 P11

DI J60-3 P12

#1127 %11 DK-START-GW5AT 138 V2.1 DVK Board 5 Gowin [¥]
FTDI T3 JTAG 42 LR MR T, W3k 8-2 fow.

= 8-2 2EWIT JTAG ¥IFBLR (Gowin B FTDI TH£%)

JTAG #11 DVK Board Gowin [ FTDI F#i4k
GND J3-8 P2
TMS J3-3 P9
TCK J3-4 P1
VREF (3.3V) J3-7 P6
TDO J3-6 P5
TDI J60-3 P3

Wl tn22#% %11 DK-START-GW5AT138 V2.1 DVK Board 5 Olimex 1/i &
2 JTAG ORI N ER T, Wik 8-3 Fiun.

= 8-3 BEWITH JTAG ¥FELR (Olimex 7 EF)
JTAG #11 DVK Board Olimex 1/i E.#%
GND J3-8 P4

MUG1031-1.2 46(55)




8 TEAH it TT ik

8.4 4K

JTAG #:1

DVK Board

Olimex 1/ H.2%

TMS

J3-3

P7

TCK

J3-4

P9

VREF (3.3V)

J3-7

P1

TRST

J3-5

P3

TDO

J3-6

P13

TDI

J60-3

P5

!

® RiscV_AE350_SOC M £ 1 “PLL_R[0] > clkout1

PLL_ADV IP fif2 B4 “PLL_R[0]”. %11, INS_LOC
"u_Gowin_PLL_AE350/PLL_inst" PLL_R[0]-

® RiscV_AE350_SOC ) DDR3 Memory 4l “PLL_L[0] > clkout2” ELJEHRML, il
29k PLL_ADV IP A2 & N “PLL_L[0]”. 140, INS_LOC
"u_Gowin_PLL_DDRS3/PLL_inst" PLL_L[0]-

8.4.2 BTFF4R

MUG1031-1.2

7 EERME, DAIZIR I

ZIATI o el NN FRZ00R, /] DS = P AT I e 24071
T.H “Timing Constraints Editor”.

BARI R iR es . “Place & Route > Timing Analysis Report”,  11[&]

8-28 fl7r.

8-28 FIF iR &5

{7 GOWIN FPGA Designer - “PGA_RefDesign\DK_START_GWSAT138 V2.1\ae350_demo\impl\pnr\ae350_dema.tr.html] — [m] x
7 Ele Edit Project Tools Window Help -8 x
] EEY  EHER T E:

Process &8 x Clock Summary: -

i | Design Summary

v [ User Constraints

1kS01 8. 20.000 | 50.000 0.000 | 10.000
B Hoorplanner STA Tool Run Summary choom i
- flash_sysclk Base 20.000 | 50.000 0.000 | 10.000
% Timing Constraints Editor Clock Summary
2e350_apb_clk Base 10.000 | 100.000 0.000 | 5.000
v O Synthesize Max Frequency Summary
ddr3_sysclk Base 10.000 100.000 0.000 5.000
Synthesis Repart Total Negative Slack Summ drs clidn — 20000 | 30.000 .000 | 10,000
Netlst File imi i ~
® » Timing Details 2e350_ddr_clk Base 10.000 | 100.000 0.000 | 5.000
v (2 Place & Route
» Path Slacks Table ddr3_memory_clk Base 3333 300,030 0.000 1.667
Place & Route Report
e Setup Paths Table 3e250_ahb_dk Base 10.000 | 100.000 0.000 | 5.000
~ Timing Analysis Report
8 fnay P Hold Paths Table U_RiscV_AE350_SOC_Top/FLASH_SPI_CLK_iobufyI Base 10.000 | 100.000 0.000 | 5.000
Parts & Pins Report
© P Recovery Paths Table u_Gowin_PLL_AE350/PLL_inst/CLKOUT1.default_gen_clk | Generated | 1.250 | 800.000 0.000 | 0.625
8 Programmer
wil "rog Removal Paths Table u_Gowin_PLL_AE350/PLL_inst/CLKOUT4.default_gen_clk | Generated | 100.000 | 10.000 0.000 | 50.000

Design  Process  Hierarchy

Console

Timing Messages

Timing Summaries

Minimum Pulse Width Table
» Timing Report By Analysis
Setup Analysis Report

Hold Analysis Report 1 clks0m 50.000{MHz) 417.014{MHz)
Recovery Analysis Report 2 ddr3_sysclk 100.000(MHz) 119.933(MHz) 7 Top
Removal Analysis Report ~ || |3 ddr3_clkin 50.000(MHz) 289.477(MHz) 7 Top -

»

Start Page

I T I T

Max Frequency Summary:

4 TOP

Design Summary

2e350_demo.tr.html

Generate file "F:\EMB_pub\embedded\risc_v\ae356_soc\ref_design\l.2\FPGA_RefDesign\DK_START_GWSAT138_V2.1\ae350_demo\impl\pnr\ae356_demo.rpt.html" completed ~
Generate file “F:\EMB_pub\embedded\risc_v\ae358_soc\ref design\1.2\FPGA_RefDesign\DK_START GWSAT138_V2.1\ae350_demo\impl\pnriae35@_demo.rpt.txt" completed
Generate file “"F:\EMB_pub‘\embedded\risc_v\ae35@_soc\ref_design\l.2\FPGA_RefDesign\DK_START_GWSAT138_V2.1\ae350_demo\impl\pnr\ae35@_demo.tr.html” completed
Tue Apr 23 14:35:31 2024

< >

%

Console Message
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8.5 MLE

8.5 I &

8.5.1 £JFHiEM

A R TEC B 5 “General” i1 “Constraints”.

“General” FEIAC & a1 P 8-29 Fra~. -

® Enable DSRAM: R E, NZi4 H DSRAM

® Output Base Name: — B N1 TFEA K

[ 8-29 £ HikTifc =

W Configuration

v Global
General
Constraints

v Synthesize
General

~ Place & Route
General
Voltage
Place
Route
Dual-Purpose Pin
Unused Pin

v BitStream
General
sysControl

Feature sysControl

General

Output Base Name: |ae350_demo

Enable DSRM

Cancel

Apply

8.5.2 {Z&1EIN

MUG1031-1.2

“Synthesize” EHIHCE, W& 8-30 fr~. ln:
® S ITHISEPRTZ B4 AR, B E Top Module/Entity

® SR THI S PRk 3CAF 5 H %42, BCE Include Path

® \erilog Language BLE, {540 System Verilog 2017
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8.5 &

& 8-30 ZRIETAL E

Ay Configuration

v Global
General
Constraints

v Synthesize
General

~ Place & Route
General
Voltage
Place
Route
Dual-Purpose Pin
Unused Pin

v BitStream
General
sysControl

Feature sysControl

Synthesize

General

Synthesis Tool: ® GowinSynthesis

Top Module/Entity: |a8350_demo_top

Include Path: |

TelPre |

GowinSynthesis

Verilog Language: | System Verilog 2017 ~

Looplimit: 2000 >
[] Show All Warnings

[] Disable Insert Pad

[ Ram R/W Check

Cancel Apply

8.5.3 T RHLIEM

i AR Rk AL & 55 “General”. “Voltage”. “Place”. “Route”.
“Dual-Purpose Pin” #1 “Unused Pin”.

SRR SLBR TR AL &, -
Place i ik Ui, E&FAmREZE 2, WK 8-31 Fin.

Route i &% i,

WAL L 2, W& 8-32 .

Dual-Purpose Pin 5, &R “SSPI”. “MSPI” #1 “CPU” A%iH

10, Kl 8-33 7.

MUG1031-1.2
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[&] 8-31 Place i TIEL B

W Configuration *
Place
v Global
oba Category: |All ~ Reset all to default
General
Constraints Label Value
“ Synthesize Place input registers to 10B False
General Place output registers to IOB False
* Place & Route Place inout registers to 10B False
G | .
Valtage ;
Replicate Resources False
Place
Route
Dual-Purpose Pin
Unused Pin
~ BitStream
General
sysControl
Feature sysControl
Place algorithm options. ~
0: default place algorithm, compilation speed priority
1: place algorithm 1, routability priority
2: place alaorithm 2. timina priority Y

Cancel Apply

[#] 8-32 Route iEIRAL B

W Configuration X
Route
~ Global
opa Category: |All ~ Reset all to default
General
Constraints Label Value
~ Synthesize Clock Route Order ]
General Run Timing Driven True
G |
snera Route Maxfan 23
Voltage R
Correct Hold Violation True
Place
Route

Dual-Purpose Pin
Unused Pin

~ BitStream

General
sysControl
Feature sysControl
v 0: default route algarithm, the default route algorithm according to ~
congestion.

1: route algorithm 1, routing according to timing.
2: route algorithm 2, routing speed will be faster. v

Cancel Apply
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8.5 &

[# 8-33 Dual-Purpose Pin i£IRfc &

b Configuration

v Global
General
Constraints

v Synthesize
General

“~ Place & Route
General
Vaoltage
Place

Route

Unused Pin
¥ BitStream
General

sysControl

Dual-Purpose Pin

Feature sysControl

Dual-Purpose Pin

[] Use JTAG as regular IO
Use S5PI as regular 10
Use MSPI as regular 10
[] Use READY as regular 10
[] Use DONE as regular 10
Use CPU as regular 10

Apply

8.5.4 GifRiEIN

MUG1031-1.2

fidh i 1% T AC B 4% General. sysControl #1 Feature sysControl, #1&

8'34 ﬁﬁ}j_‘—\‘o

& 8-34 ISR ETEL B

W Configuration

v Global
General
Caonstraints

“ Synthesize
General

~ Place & Route
General
Valtage
Place

Route

Unused Pin
~ BitStream
General

sysControl

Dual-Purpose Pin

Feature sysControl

BitStream

Enable CRC Check
[] Enable Compress
[] Enable Encryption

Key{Hex):

Enable Security Bit
Secure Mode

Power On Reset Monitor

Print BSRAM Initial Value

Bitstream Format: |Text v

Apply
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8.6 ZRE

IEBA I 4E T H “GowinSynthesis”, %4:4 RiscV_AE350_SOC fifi
fRsrt, AR, ik 8-35 Frs.

8-35 42 &

¥ GOWIN FRGA Designer FPGA _RefDesign\DK START GWSAT138 V2.112e350_demo\impl\gwsynthesis\ae350_ demo_syn.rpthimi] - o x
7 Hle Edit Project Tools Windew Help _lax
LY TTEY Y BT T

Process 8 x -

Synthesis Details

1| Design Summary

Synthesis Messages Top Level Module a€350_demo_top

v [F User Constraints
Synthesis Details Running parser:

CPU time = 0h Om 15, Elapsed time = oh 0m 2s, Peak memory
usage = 202.918MB
Running netlist conversion:

CPU time = 0h Om 05, Elapsed time = 0h 0m s, Peak memory
usage = OMB
Running device

[ZE FloorPlanner
7 Timing Constraints Editor Resource

v (D synthesize
-~ Synthesis Report

Resource Usage Summary

Resource Utilization Summary ind dent optimizati
ndependent optimization:

Netlst File Timing Optimizing Phase 0: CPU time = Oh Om 0.14s, Elapsed time = Oh
0m 0.215s, Peak memory usage = 202.918MB
v Place & Route. Clock Summary Optimizing Phase 1: CPU time = Oh Om 0.14s, Elapsed time = oh
0m 0.15s, Peak memory usage = 202.018MB

Place & Route Report Max Frequency Summary Optimizing Phase 2: CPU time = Oh Om 0.109s, Elapsed time = 0h
0m 0.117s, Peak memory usage = 202.918M8
Running inference:

Inferring Phase 0: CPU time = Oh 0m 0.171s, Elapsed time = 0h
0m 0.308s, Peak memory usage = 202.918MB

Inferring Phase 1: CPU time = Oh 0m 0.0155, Elapsed time = 0h
0m 0.054s, Peak memory usage = 202.918MB

Inferring Phase 2: CPU time = Oh Om 0.046s, Elapsed time = 0h
0m 0.072s, Peak memory usage = 202.918MB

Inferring Phase 3: CPU time = Oh Om 0.015s, Elapsed time = 0h
0m 0.017s, Peak memory usage = 202.018M8
Running technical mapping:

Tech-Mapping Phase 0: CPU time = Oh Om 0.093s, Elapsed time =
0h Om 0.09s, Peak memory usage = 202.918M8

Tech-Mapping Phase 1: CPU time = Oh Om 0.062s, Elapsed time =
0h Om 0.0595, Peak memory usag .918MB

Tech-Mapping Phase 2: CPU time
0h 0m 0.032s. Peak memory usace = 202.918Hi

Timing Analysis Report Detail Timing Paths Informations

Ports & Pins Report

1 programmer

Synthesis Pracess

Oh Om 0.031s, Elapsed time =
5 -

Design  Process  Hierarchy ? Start Page Design Summary ot a€350_demo_syn.rpthtml

Console & X
Generate file “F:\EMB_pub\embedded\risc_v\ae350_soc\ref_design\l.2\FPGA_RefDesign\DK_START GWSAT138_V2.1\ae350_demo\impl\pnr\ae35e_demo.rpt.html” completed
Generate file "F:\EMB_pub\embedded\risc_v\ae358_soc\ref design\l.2\FPGA RefDesign\DK_START GWSAT138 V2.1\ae358_demo\impl\pnr\ae35@_demo.rpt.txt" completed
Generate file "F:\EMB_pub\embedded\risc_v\ae358_soc\ref_design\1.2\FPGA_RefDesign\DK_START_GHSAT138_V2.1\ae35€_demo\impl\pnr\ae356_demo.tr.html" completed

Tue Apr 23 14:35:31 2024 v
< >
%

Console  Message

8.7 Ttk

R AT AT 2k T B “Place & Route”, M RATEMR S, 74
i sct, anlEl 8-36 Fr.

& 8-36 ThEfhLk

& GOWIN FPGA Designer

PGA_RefDesign\DK_START_GWSAT138_V2.1\ae350_demo\impl\pnr\ae350_demo.rpthiml] - u] x

7 Fle Edit Project Tools Window Help

ST B =

Process 8 x

PnR Details -

1 | Design Summary

v TR User Constraints PnR Messages Running placement:

- Placement Phase 0: CPU time = 0h Om 1s, Elapsed time = Oh Om 1s
2L FloorPlanner PnR Details Placement Phase 1: CPU time = Oh Om 0.222s, Elapsed time = Oh Om 0.2225
— Resource Placement Phase 2: CPU time = 0h Om 2s, Elapsed time = Oh Om 2s.

% Timing Constraints Editor

Placement Phase 3: CPU time = Oh Om 185, Elapsed time = Oh Om 185

Total Placement: CPU time = 0h 0m 225, Elapsed time = oh Om 225
Running routing:

Routing Phase 0: CPU time = 0h Om 0.839s, Elapsed time = 0h 0m 0.839s

Routing Phase 1: CPU time 0m 435, Elapsed time = 0h 0m 435

Routing Phase 2: CPU time

Routing Phase 3: CPU time

Total Routing: CPU time = Oh Om 44s, Elapsed time
Generate output files:

CPU time = 0h Om 115, Elapsed time = Oh Om 11s

Resource Usage Summary

1/0 Bank Usage SumbiShy- Route Process

v @ synthesize
Synthesis Report

Netlst Flle Global Clock Usage Summary

v @ Place & Route Global Clock Signals|
Pinout by Port Name

All Package Pins

= Place & Route Report
Timing Analysis Repart
Ports & Pins Report

Total Time and Memory Usage | CPU time = Oh 1m 175, Elapsed time = Oh 1m 175, Peak memory usage = 1419MB

1% programmer

Resource

Resource Usage Summary:

MUG1031-1.2

Resource Usage
Logic 4164/138240 4% v

. »

Design  Process  Hierarchy 7 Start Page Design Summary e350_demo.rpthtml

Console & X

Generate file "F:\EMB_pub\embedded\risc_v\ae35¢_soc\ref design\l.2\FPGA RefDesign\DK_START_GWSAT138_V2.1\ae356_demo\impl\pnr\ae350_demo.rpt.html" completed ~

Generate file "F:\EMB_pub\embedded\risc_v\ae350_soc\ref design\l.2\FPGA RefDesign\DK_START_GWSAT138_V2.1\ae35@_demo\impl\pnr\ae356_demo.rpt.txt” completed

Generate file "F:\EMB_pub\embedded\risc_v\ae350_soc\ref_design\1.2\FPGA_RefDesign\DK_START GWSAT138 V2.1\ae358_demo\impl\pnr\ae35@_demo.tr.html" completed

Tue Apr 23 15:83:54 2824 v

< >

%

Console ~ Message
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8.8 T&;

IRBAR T ECC A “Programmer”, N #053 SCAF.

=R AE, “Process > Program Device”, i3 :3ZH#. “Tools >
Programmer”, B¢ T H A2 “I48”, $TH Programmer.

1% $¢ Programmer 32 ¥ “Edit > Configure Device”, =T HA*
AT, A N EOEIT, & 8-37 Fn.

“Access Mode” THi%|#, iE$F “External Flash Mode 5AT”,

“Operation” THi%&, & “exFlash Erase, Program 5AT” &%
“exFlash Erase, Program, Verify 5AT”.

“Programming Options > File name” &3, I AR SCAES
“External Flash Options > Device” &1, #%# “Generic Flash”.

“External Flash Options > Start Address” &1, &N
“0x0000007,

M “Save”, SERN FEGETIACE .
8-37 THIEINALE

v‘i’- Device configuration ? x

Tevice Operation
Access Mode: External Flash Mode GAT ~

Operation: exFlazh Eraze, Frogram BAT R

exFlash Eraze, Frogram BAT

Frogramming Options

File name: |[E_START_GWEATI3S_W2.1/ae350_demo/impl /pre/ae360_demo. Es| D

Femainz User Flash Unchanged
User Flash Initialization

External Flazh Options

Device: Generic Flash e

Start Address: Q000000

Save Cancel

SR BGATI B )5, i TR 087, NERSROCH:, ikl 8-38
I
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& 8-38 FEMBHR I

¥ Gowin Programmer m} X
File Edit Tools About
 cmcg | L Es 5| vss cable sertine
Enable Series Device Operation FS File User Code
1 GWSAST GWSAST-138B  exFlash Erase,Program SAT F/EMB_pub/embedded/risc_v/ae350_soc/... 0x00000A9D
< >
Qutput g X
Info Target Cable: Gowin USB Cable(FT2CH)/0/353/null@15MHz
Info Target Device: GWS5AST-138B(0x00010818)
Info Operation "exFlash Erase,Program SAT" for device#1...
Info Status Code is: 0x00020638
Info Try to program spi flash: 0xC84018!
Info Programmning Flash starts from 0x0.
Info Programmning Flash ends from 0x4616.
Info Program sFlash finished.
Info The device is reloading, please check later...
Info Finished.
Info Cost 72.76 second(s)
Ready
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9%%‘1‘&%

Gowin RiscV_AE350_SOC # (Rl 1F 1) 5% Uit

...\ref_design\FPGA_RefDesign\DK_START_GWS5AT138_V2.1\ae350
_demo

...\ref_design\FPGA_RefDesign\Tang_ MEGA_138K_Pro_Dock\ae350
_demo

...\example\Ethernet\ref _design\FPGA RefDesign\Tang MEGA 138K
_Pro_Dock\ae350 ext_ethernet

...\example\CAN\ref_design\FPGA_RefDesign\DK_START GW5AT13
8 V2.1\ae350 ext can

...\example\AHB_Slave Bridge\ref design\FPGA_RefDesign\DK_STA
RT_GW5AT138_V2.1\ahb_to_ahb_16_bridge

...\example\Flash\ref _design\FPGA_RefDesign\DK_START_GWJ5AT1
38 V2.1\ae350 ext flash

...\example\SD\ref _design\FPGA RefDesign\DK_START_ GW5AT138
_V2.1\ae350 _ext sd

...\example\APB_Slave Bridge\ref design\FPGA _RefDesign\DK_STA
RT_GW5AT138 V2.1\apb_to _apb_16_bridge

...\example\AHB_Master\ref _design\FPGA_RefDesign\DK_START_ G
W5AT138 V2.1\ae350 ahb_master

...\example\Customized\ref design\FPGA_RefDesign\DK_START_G
W5AT138 V2.1\ae350_ customized

...\example\DDR3_shared\ref design\FPGA RefDesign\DK_START _
GW5AT138_V2.1\ae350_shared_ddr3

...\example\TCM\ref _design\FPGA_RefDesign\DK_START_GW5AT13
8 V2.1\ae350_emb_ tcm
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